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Objective: The objective of this study was to investigate how the supplemental use of Folic Acid and Cobalamin impacts the levels 

of collagen and elastin in the lung tissue of female Sprague-Dawley rats. 

Study Design: Laboratory-based Experimental Study 

Place and Duration of Study: This study was carried out at the anatomy department of the CMH Multan Institute of Medical 

Sciences  Pakistan from September 2020 to September 2021. 

Methodology: In this study, one hundred and twenty female Sprague-Dawley rats were used and divided into four groups. Each 

group comprised thirty adult female rats. Group A received a daily oral gavage of 1ml/100g of pure distilled water for four weeks. 

Group B1 received a daily oral gavage of 0.2mg/kg of folic acid in 1ml/100g of pure distilled water for four weeks. Group B2 

underwent a daily oral gavage of 45µg/kg of cobalamin in 1ml/100g of pure distilled water over four weeks. In the case of Group 

B3, both folic acid (0.2mg/kg) and cobalamin (45µg/kg) were administered as supplementary doses in 1ml/100g of distilled water 

by oral gavage daily for four weeks. After 28 days of drug administration, the rats from all four groups were sacrificed. Sections 

were processed, and slides were stained with Masson’s Trichrome and aldehyde fuchsin for a light microscopic study. Data was 

entered and analysed via SPSS version 26. 

Results: The study revealed statistically significant differences in collagen and elastin content between the control and experimental 

groups. Specifically, the experimental groups showed an increased percentage of collagen and a decreased percentage of elastin 

compared to the control group. 

Conclusion: This experimental study shows that long-term administration of supplementary Folic Acid and Cobalamin doses 

brings about changes in the collagen and elastin content of lung tissue. 
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The water-soluble B vitamins are essential coenzymes that are required for optimal cellular function. The group of 

vitamins known as Vitamin B consists of Thiamine (B1), Riboflavin (B2), Niacin (B3), Pantothenic acid (B5), 

Pyridoxal (B6), Biotin (B7), Folate (B9), and Cobalamin (B12). 1 Folic acid and Cobalamin are essential components 

of a balanced diet. In cells undergoing chromosomal replication and division, a deficiency in either of these vitamins 

can impede DNA synthesis. 2 

The recommended dietary allowance of folate and Cobalamin for an adult person is 400 and 2.4 micrograms per day, 

respectively. 3 Due to their importance, food is fortified with these vitamins. However, fortifying has led to a 

widespread increase in folic acid and Cobalamin intake that exceeds the body's physiological requirements. Serum or 

plasma folate levels exceeding 45nmol/L (19.8 ng/mL) in blood samples obtained after fasting are frequently 

categorised as supraphysiological. Findings from the National Health and Nutrition Examination Survey conducted 

between 1999 and 2000 indicated that around a quarter of the population exhibited serum folate concentrations 

considered supraphysiological. 4 

Folic acid (Pteroyl glutamic acid) is made up of a pteridine ring, para-aminobenzoic acid, and glutamate, all of which 

are connected by a methylene bridge. Folic acid itself does not possess biological activity. However, it converts into 

its active forms in the liver, namely dihydrofolic acid and tetrahydrofolic acid. 5 Tetrahydrofolate is a part of the one-

carbon metabolism process, which is what makes thymidylate, purines, and pyrimidines, which are needed for DNA 

replication. The amino acids serine, histidine, and glycine primarily contribute this one-carbon unit to tetrahydrofolate. 

The attachment of these carbon units to tetrahydrofolate enables it to be either oxidised or reduced. By donating a 

carbon atom from its side chain to folate, serine aids in the transformation of serine into glycine and tetrahydrofolate 

(THF) into methylene tetrahydrofolate (mTHF). Methylene tetrahydrofolate (mTHF) is a carbon donor in the 

methionine cycle. 6 Cobalamin is the largest of the B-complex vitamins. It comprises a porphyrin ring composed of 

four pyrroles, similar to haem, with the distinction that cobalt is positioned at the center of the ring instead of iron. 2 

Cobalamin is necessary for the normal metabolism of folate because it acts as a cofactor in the methionine cycle. 7 

Folic acid and Cobalamin have extensive applications in the treatment of megaloblastic anaemia and as preventive 

measures against neural tube defects (NTDs). 8 Food is fortified with folic acid and cobalamin in many countries, 

including Pakistan, to prevent nutritional deficiencies. 9, 10 A recent study revealed that excessive supplementation 

with Folic acid and Cobalamin is linked to alterations in the DNA methylation of multiple genes potentially associated 

with carcinogenesis. 11 A retrospective cohort study identified a correlation between high-dose supplementation of 

vitamin B6 and Cobalamin and an elevated risk of lung cancer. 12 

Lung cancer is the second most common cancer in terms of incidence and ranks first in terms of cancer-related 

mortality. Lung cancer is common in both males and females, but historically, it has been more prevalent in males. 

However, in recent years, the gap in lung cancer rates between genders has been narrowing, and the incidence of lung 

cancer in females has been increasing. 13 This study had two main goals. Firstly, this study was conducted to investigate 

the association between these vitamins and lung cancer since no experimental studies have been undertaken to confirm 

their relationship, aiming to bridge the knowledge gap. Secondly, the study aims to quantify the collagen and elastin 

components of lung tissue in histology slides with image J. 

Material And Method 

The research investigation took place within the research laboratory of the Department of Anatomy at the CMH Multan 

Institute of Medical Sciences, Pakistan. One hundred and twenty healthy female Sprague-Dawley rats were obtained 

from The University of Veterinary and Animal Sciences (UVAS) Lahore, a renowned research institute known for its 

veterinary laboratories. Sprague-Dawley rats are widely recognized as highly suitable experimental models and are 

extensively used in research globally. 14 
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Pregnant rats and rats exhibiting any physical deformities were excluded from the study. The selection of rats was 

based on a random sampling method. The study included four groups: one control (A) and three experimental (B1,2,3). 

Each group comprised thirty adult female rats. Group A received a daily oral gavage of 1ml/100g of pure distilled 

water for four weeks. Group B1 received a daily oral gavage of 0.2mg/kg of folic acid in 1ml/100g of pure distilled 

water for four weeks. Group B2 underwent a daily oral gavage of 45µg/kg of cobalamin in 1ml/100g of pure distilled 

water over four weeks. In the case of Group B3, both folic acid (0.2mg/kg) and cobalamin (45µg/kg) were 

administered as supplementary doses in 1ml/100g of distilled water by oral gavage daily for four weeks. With the 

assistance of a reference article and a pilot procedure, we selected the optimum dose. 15, 16 Control and experimental 

animals were kept under the same conditions. Day 0 was considered the first day of the experiment. After 28 days of 

drug administration, the rats from all four groups were sacrificed. The weight of all the animals was taken before 

sacrifice. The rats were euthanized by chloroform inhalation, and when the rats showed no respiratory or body 

movements, they were placed on a clean sheet of paper on dissecting board for dissection. 17 Skin and muscle covering 

the ventral thoracic and cervical regions were removed using scissors and forceps. Proceeded by making two lateral 

cuts on each side of the ribcage and an additional one near the clavicle to open up enough space for a comprehensive 

examination of all lung lobes. This will expose the heart and lungs for further observation. Hold the trachea close to 

the jaw using forceps, then make a complete cut through the trachea using scissors positioned above the forceps. 

Delicately elevate the trachea with the forceps, carefully severing tissue connections on the underside using scissors, 

until the complete assembly of thoracic tissues (including the trachea, lungs, and heart; often referred to as the "pluck") 

has been successfully extracted from the body. Lay the lungs flat on the work surface. Place the lungs into fixative 

using an approximate 20:1 fixative-to-tissue ratio. A transverse section of the left lobe was taken for histopathology. 
18, 19 Sections were processed, and slides were stained with Masson’s Trichrome and aldehyde fuchsin for a light 

microscopic study. Slide photographs were taken with a 40X objective lens using the Adobe Photoshop Lightroom 

version 20.0.4 application on a mobile camera. The percentage of collagen fibres per unit area and the percentage of 

elastic fibres per unit area in the lung tissue were measured using Image-J software, a public-domain, Java-based 

image processing software developed at the National Institute of Health (USA) in 1997. The Color Thresholding 

Method was applied to quantify Collagen and Elastin. Hong et al. demonstrated the quantification of collagen or 

elastin visible in histological photographs using ImageJ,based on their unique colour.20 For this study, ImageJ was 

opened, and its scale was calibrated by opening the image of the stage mmicrometre taken with the same camera and 

magnification settings as the other photographs. Next, Analyze > Set Measurements was accessed, and 'Area' and 

'Limit to Threshold' were selected while deselecting other measurements. Afterwards, the image was opened for 

measurement, ensuring it was captured at the same magnification and camera system as the stage 

mmicrometrephotograph used for scale calibration. To measure the area of the entire picture, Analyze > Measure or 

the keyboard shortcut 'Ctrl + M' was utilized, displaying the results in a separate window. The Hue, Saturation, and 

Brightness were adjusted using the default method by going to Image > Adjust > Color Threshold to accurately capture 

the color of interest, such as blue in the Masson Trichrome staining. Subsequently, Analyze > Measure or 'Ctrl + M' 

was used again to calculate the area of the selected region in calibrated units, and the results were recorded. Finally, 

with the measurements taken, the percentage of collagen in the images was calculated by applying the formula. The 

same method was applied to quantify the elastin component. The data was expressed as mean ± S.D (Standard 

Deviation). A one-way ANOVA followed by the post-hoc Tukey test was applied to quantitative variables to detect 

any significant differences between the experimental and control groups. 

RESULTS 

The study revealed significant differences in collagen and elastin content between the Control and experimental 

groups. Specifically, the experimental groups showed an increased percentage of collagen and a decreased percentage 

of elastin compared to the control group, as shown in Figure I. 
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The percentage area of collagen per unit area in rats' lung tissue (%) was calculated for both the control group and the 

experimental groups. The mean percentage area of collagen in lung tissue of Group A (Control) was 12.57 ± 9.17 %, 

for B1 (Folic Acid) it was 18.63 ± 8.35 %, for B2 (Cobalamin Group) 21.47 ± 10.00 %, and for B3 (F.A. + Cobalamin 

Group) 23.77 ± 10.30 %. The overall ANOVA showed a significant difference between the Control and Experimental 

groups (p = 0.000). (Figure II) 

Pair-wise comparison by post hoc Tukey test showed that the group A (control)'s percentage of collagen per unit area 

in the lung tissue was significantly lower than the B2 (cobalamin) (p = 0.002) and B3 (f.a. + cobalamin) groups (p = 

0.000). 

The percentage area of elastin per unit area in rats' lung tissue (%) was calculated for both the control group and the 

experimental groups. The mean percentage area of elastin in lung tissue of Group A (Control) was 24.80 ± 7.78%, for 

B1 (Folic Acid) it was 6.17 ± 3.84%, for B2 (Cobalamin Group) 8.10 ± 3.45%, and for B3 (F.A. + Cobalamin Group) 

8.00 ±  4.18%. The overall ANOVA showed a significant difference between the groups (p = 0.000). (Figure III) 

Pair-wise comparison by post hoc Tukey test showed that the group A (control)'s percentage of elastin per unit area 

in the lung tissue was significantly higher than that of B1 (folic acid) (p = 0.000), B2 (cobalamin) (p = 0.000), and B3 

(F.A. + cobalamin) groups (p = 0.000). 

  

Figure I: Quantification of the elastin component using ImageJ software. 
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 Figure I I: Mean percentage of collagen per unit area in lung tissue 

 Figure III: Mean percentage of elastin per unit area in lung tissue 
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DISCUSSION: 

The present study investigated the effect of folic acid and cobalamin supplementation on collagen and elastin content 

in rats' lung tissue using an experimental approach and image analysis. The water-soluble B vitamins, folic acid, and 

cobalamin are essential coenzymes required for optimal cellular function. 1, 2 They play crucial roles in DNA synthesis 

and chromosomal replication. Despite their importance, excessive supplementation has become a concern due to 

widespread fortification of foods, leading to supraphysiologic serum folate concentrations in a significant portion of 

the population. 4 

The results revealed significant differences in collagen and elastin content among the groups. The experimental groups 

(B1, B2, and B3) showed altered percentages of collagen and elastin compared to the control group (Group A). Group 

B1 (folic acid) exhibited a higher percentage of collagen, while Groups B2 (cobalamin) and B3 (folic acid + 

cobalamin) showed even higher collagen content compared to the control. On the other hand, Group A had a 

significantly higher percentage of elastin compared to the experimental groups, indicating a potential role of folic acid 

and cobalamin in modulating elastin content in lung tissue. 

The findings of an increased collagen component in the experimental groups are consistent with previous studies 

showing that folic acid and cobalamin are involved in one-carbon metabolism, which is essential for DNA synthesis 

and cellular division. 21 The alteration in the collagen component can impact the lung's ability to heal and adapt to 

various conditions, potentially affecting overall lung health and function. However, further investigations are required 

to understand the mechanisms underlying this effect. 

Conversely, the decrease in elastin content observed in the experimental groups might have important implications 

for lung function and elasticity. Elastin is a crucial component of lung tissue, allowing it to expand and recoil during 

the breathing process. 22 The decreased elastin content impacts lung compliance and respiratory function, warranting 

further investigation into its physiological significance. 

The association between folic acid and cobalamin supplementation and lung cancer has been a subject of interest in 

recent research. Some studies have reported potential links between high-dose supplementation of vitamins B6 and 

B12 and lung cancer risk. 23, 24 In the context of this study, it is essential to consider the potential impact of altered 

collagen and elastin content on lung tissue integrity and function, as these components play significant roles in 

maintaining the structural integrity of the lungs. 25 

However, it should be noted that this study has some limitations. Firstly, the experiment was conducted on female 

rats, and gender-specific effects cannot be ruled out. Secondly, the study period was limited to four weeks, and the 

long-term effects of folic acid and cobalamin supplementation were not explored. 

These findings contribute to the ongoing research on the potential health consequences of excessive folic acid and 

cobalamin intake and their relevance to lung cancer risk. Future studies may explore gender-specific effects and long-

term outcomes to provide a comprehensive understanding of the impact of these essential B vitamins on lung health. 

CONCLUSION 

This experimental study shows that long-term administration of supplementary Folic Acid and Cobalamin doses brings 

about changes in the collagen and elastin content of lung tissue. 
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